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WHAT'S NEW IN EXCEL 2016? 
 

1. New Charts - Excel 2016 has six new chart types, as follows: 
 

Two new Hierarchy charts: 
Treemap  
Sunburst  

 
One new Waterfall chart: 

Waterfall (or Stock Chart)  

 
Three new Statistical charts: 

Histogram 
Pareto 
Box and Whisker. 

 
Example Treemap Chart 
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Example Sunburst Chart 
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Example Waterfall chart 
 

 
 

Example Histogram Chart 
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Example Pareto Chart 



Copyright November 2017 – J. Carlton Collins, CPA  Page 7 

 
 

Example Box and Whiskers Chart 
 

2. New Get and Transform Power Query 
 
Excel 2016 provides new capabilities that were previously only available as a separate add-in 
called Power Query, but are available natively within Excel. This new functionality is found on the 
Get & Transform group on the Data tab, as pictured below. 
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3. Exponential Forecasting & One Click Forecasting 
 
In Excel 2016, the FORECAST function has been extended to allow forecasting based on 
Exponential Smoothing (such as, FORECAST.ETS() …). This functionality is also available as a new 
one-click forecasting button. To use this functionality, on the Data tab, click the Forecast Sheet 
button to quickly create a forecast visualization of your data series. From the wizard, you can also 
find options to adjust common forecast parameters, like seasonality, which is automatically 
detected by default and confidence intervals. 
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4. 3D Maps 
 
Power Map, has been renamed to 3D Maps and is now available in all Excel 2016 versions. This 
functionality is available (along with other visualization tools) by clicking 3D Map on the Insert 
tab. 
 

 
 

NEW MAPPING TOOLS ON EXCEL 2016 
 
Microsoft Excel 2016 another new mapping capabilities. The first mapping option is a regular 
two-dimensional world map. To use this map tool, highlight your data (cells A2:A5 and C2:C5 in 
the example below) and from the Insert tab select Maps, Filled Map. The resulting chart (also 
pictured below) is a basic world diagram displayed as a heat map, and your options for editing or 
enhancing this map are limited primarily to changing colors and repositioning the legend. 
Nonetheless, this basic mapping tool may meet your needs. (I have uploaded a YouTube video of 
this topic at tinyurl.com/z5sutz7.) 
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For more powerful mapping capabilities, Excel 2016 also offers 3-D mapping. To use the 3-D 
mapping tool, select your data (cells A1:C5 from the same data set pictured above) and from the 
Insert tab select 3D Map, Open 3D Maps to launch the 3-D mapping tools pictured below (an 
internet connection is required).  
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After plotting your geography data in 3D Map, you can then use the Layer Pane function (pictured 
above to the right) to edit and reformat your map. By default, the 3D Map tool displays a column 
over each country, but you can change this format to instead display a Bubble chart, Region 
chart, or Heat Map. You can also rotate and zoom the 3-D map, change colors, apply filters, and 
add additional map layers as overlays. As an example, the simplified data set used above 
produces the following 3-D world map. 

 
 

 
 
If desired, you can convert the 3-D map to a 2-D map, add text, and even animate the map, if 
dates or times are included in the data set. Once you have completed your 3-D map, built-in 
broadcasting tools enable you to record your voice narration describing the map as you rotate 
the image to view different angles and animate the map to convey data trends over time. The 
resulting video clip is called a “scene,” which can be coupled with other scenes to produce a single 
video of your data set. The entire video can then be published to a variety of destinations, such 
as YouTube.com, using the Create Video option, pictured below.   
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The 3D Map tool recognizes many standard location descriptions including street address, city, 
county, state, province, ZIP code, postal code, country, region, or even longitude and latitude 
coordinates.  
 

5. PivotTable Enhancements 
 
Power Pivot (available as an add-in since Excel 2007) and the Data Model (added in Excel 2013), 
provide ability to easily build sophisticated models across your data, augment them with 
measures and KPIs, and then calculate over millions of rows with high speed. Not only have these 
enhancements been added to Excel 2016, these following improvements have also been made.  
 

a. Automatic relationship detection – Excel 2016 automatically discovers and creates 
relationships among the tables used for your workbook’s data model, so you don’t have 
to. Excel 2016 knows when your analysis requires two or more tables to be linked together 
and notifies you. With one click, it builds the relationships for you. 

 
b. Creating, editing and deleting custom measures – Excel 2016 allows you to create and 

edit custom measures directly from the PivotTable fields list. 
 

c. Automatic time grouping – Excel 2016 automatically groups your time-related fields 
(year, quarter, month) in your PivotTable. Once grouped together, you can drag the group 
to your PivotTable in one action to distribute your data across the different levels of time 
with drill-down capabilities. 

d. PivotChart drill-down buttons - Excel 2016 allows you to zoom in and out across 
groupings of time and other hierarchical structures within your data. 
 

e. Search in the PivotTable – A new field format list helps you get to the fields that are 
important to you across your entire data set. 
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f. Smart rename - Excel 2016 now enables you to rename tables and columns in your 
workbook’s data model. With each change, Excel 2016 automatically updates any related 
tables and calculations across your workbook, including all worksheets. 

 
g. Delayed PowerPivot Updates – A new delayed updating feature allows you to make 

multiple changes in Power Pivot without having to wait until each is propagated across 
the workbook. All applied PowerPivot changes are updated upon closing the PowerPivot 
window. 

 

 
 

h. Multi-select slicer - Now you can now select multiple items in an Excel slicer on a touch 
device (previously only one item in a slicer could be selected at a time using touch input).  
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6. Publish and share your analysis with Power BI - You can now share Power BI reports with your 
workgroup or clients online through with a simple button click. Once published to Power BI, you 
can construct interactive reports and dashboards, and display your fully formatted Excel 
worksheets. 
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7. Quick Shape Formatting – New default shape styles have been added in Excel 2016.  
 

 
 

8. Insert pictures with the correct orientation - With automatic image rotation, once you insert an 
image into Excel, it automatically rotates the picture to match the camera’s orientation. You can 
manually rotate the image to any position after insertion. Note that this only affects newly 
inserted images and does not apply to pictures in existing documents.  
 

9. Do things quickly with Tell Me - You'll notice a text box on the ribbon in Excel 2016 that says Tell 
me what you want to do. This is a text field where you can enter words and phrases related to 
what you want to do next and quickly get to features you want to use or actions you want to 
perform. You can also choose to get help related to what you're looking for, or perform a Smart 
Lookup on the term you entered.  
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10. Insights into what you're working on - The Insights pane, powered by Bing, offers more than just 
definitions. When you select a word or phrase, right-click it, and choose Smart Lookup, the 
insights pane will open with definitions, Wiki articles, and top related searches from the web. You 
can also get to Smart Lookup any time by going to Review > Smart Lookup and entering a query 
there. 
 

 
 

11. Ink Equations - Including math equations has gotten much easier. Now, you can go to Insert > 
Equation > Ink Equation, any time you want to include a complex math equation in your 
workbook. If you have a touch device, you can use your finger or a touch stylus to write math 
equations by hand, and Excel will convert it to text. (If you don't have a touch device, you can use 
a mouse to write, too). You can also erase and select and correct what you've written as you go. 
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12. Simpler sharing - Choose Share on the ribbon to share your spreadsheet with others on 
SharePoint, OneDrive, or OneDrive for Business. These changes bring together two key aspects 
of collaboration: who has access to a given document and who is currently working with you on 
the document. Now you can view both pieces of information in one place from the Share dialog 
box.  
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13. Improved version history - Now you can go to File > History to see a complete list of changes 
that have been made to your workbook and access earlier versions.  
 

 
 
Note   This feature is only supported for files stored on OneDrive for Business or SharePoint. 
 

14. New themes 
 

 
 
There are now three Office themes that you can apply : Colorful, Dark Gray, and White. To access 
these themes, go to File > Options > General, and then click the drop down menu next to Office 
Theme. 
 

15. Data Loss Protection (DLP) in Excel - Data Loss Protection (DLP) is a high-value enterprise feature 
that is well loved in Outlook. We are introducing DLP in Excel to enable real time scan of content 
based on a set of predefined policies for the most common sensitive data types (e.g., credit card 
number, social security number, and US bank account number). This capability will also enable 
the synchronization of DLP policies from Office 365 in Excel, Word, and PowerPoint, and provide 
organizations with unified policies across content stored in Exchange, SharePoint and OneDrive 
for Business.  
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RULES FOR DESIGNING EXCEL WORKBOOKS 
 
By following a common set of spreadsheet design rules, companies can produce more consistent 
workbooks that may be easier to review, edit, and use by others in their organizations. In this 
spirit, in 1987, I served on an AICPA committee that created a booklet titled Policies and 
Procedures for Standardizing Spreadsheet Design. Presented below are some of the suggestions 
from the committee’s work, which I believe still hold true today, updated for today’s technologies 
and including a few new suggestions of my own.  (These suggestions apply more to workbooks 
that are frequently or heavily used; simple “scratch calculations” and “one-time only” workbooks 
would likely not benefit much from implementing the suggestions/measures set forth below).   
 

1. Documentation. Every workbook you create should contain a documentation page that 
details the title, creators, reviewers, the date created, the client(s) involved (if any), and 
a description of what the template is designed to accomplish (if it’s not obvious).  

2. Table of contents. Larger workbooks may benefit from a table of contents page with links 
to the numerous worksheets, as suggested in the screenshot pictured below.   

 

3. Print macro buttons. Workbooks with numerous reports may benefit from including an 
assortment of print macro buttons for faster printing of various reports, or combinations 
of the reports, contained in the workbook, as suggested in the screenshot pictured above.  

4. Avoid embedded assumptions. Users should avoid embedding their assumptions in 
formulas for several reasons. Embedded assumptions don’t print to paper, so the reader 
can’t see the assumptions used. In addition, changing embedded assumptions is more 
difficult (and hence less efficient) when you must track down the location of each 
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assumption and then edit the formulas to make the desired changes. It’s also more 
difficult to attach error-checking formulas to assumptions that are embedded in other 
formulas.  

5. Well-organized worksheet assumptions. Many Excel worksheets involve assumptions, 
such as interest rates, inflation factors, revenue and expense amounts, etc. Novice Excel 
users tend to scatter their assumptions throughout their workbooks, which can make the 
worksheet more difficult to review and later modify. The better approach may be to list 
worksheet assumptions only once, in a well-labeled and well-organized list of 
assumptions. Thereafter, formulas used throughout the workbooks should reference 
those assumptions. An example of well-labeled, well-organized assumptions is pictured 
below.  

 

 

6. Assumptions in yellow cells. I like to organize my assumptions further by highlighting 
each cell containing them in yellow with a black border, which makes it easier for me, as 
well as those I work with who are used to my design approach, to better follow my 
workbooks. An example of this is pictured above. 

7. Name assumption cells. In some cases, it can be advantageous to label your assumptions 
using Excel’s Name Box tool. By naming the assumption cell, you can also reference the 
cell name when creating formulas instead of typing the cell reference. This can make the 
formula easier to write and review. Additionally, the Go To command (F5 key in Excel) can 
be used to quickly navigate to named ranges.       

8.   
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For example, if one assumption is the consumer price index (as pictured in cell B4 above), 
you can name the cell that contains that assumption as CPI by selecting cell B4, and then 
in the Name Box typing CPI, and pressing Enter. An example of a resulting formula, which 
references the named cell CPI, is pictured below.  

 

 

9. Error-checking formulas. To help prevent input errors, I like to include error-checking 
formulas next to my formulas when warranted. For example, if the workbook template 
provides cell B4 for entering an interest rate, users trying to enter, say, “5%” may not 
know whether to enter 5 or .05. To make sure users (including myself) get it right, I might 
include the error checking formula =IF(B4>1,"Error - please use a decimal number, such 
as .02 instead of 2","") next to the assumption, as pictured below. This formula might alert 
users when a mistake has been made.    

 

10. Organize your template by worksheets. When creating an Excel workbook, the sections 
of your work should be organized on different worksheets. For example, your 
assumptions may be organized on worksheet 1, your revenue calculations on worksheet 
2, your expense calculations on worksheet 3, your income statement on worksheet 4, 
your balance sheet on worksheet 5, etc. This approach makes it easy to tab between each 
section and makes it easier to print each section. Years ago, when spreadsheet 
applications provided only a single worksheet, extra effort was required to select print 
ranges from the single worksheet and force the pages to break at the desired locations. 
However, when your workbook is organized by worksheets, printing each section is simply 
a matter of selecting the desired worksheets and pressing the Print command. An 
example of a workbook with organized worksheet tabs is pictured below. 
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11. Simplify complex calculations. When faced with the need to create a complicated 
formula involving numerous functions and/or cell references, consider breaking that 
formula into a series of simplified calculations across multiple cells. The result will be 
formulas that are easier to troubleshoot, and a worksheet that is easier to review.  

12. Explanations. When the situation calls for an explanation, it can be advantageous to 
insert a Text Box or Balloon Callout in your worksheet to explain the underlying 
methodology or simply to provide instructions for using it. This can be done from the 
Insert tab by selecting Shapes and then in the Basic Shapes section, select Text Box, or in 
the Callouts section, select Speech Bubble. Not only can these explanations be useful to 
others, but also, I’ve found them useful years later as they remind me of how the 
worksheet is intended to be used, an example of which is pictured below. 

 

13. Consistent look and feel. I prefer to turn off the gridlines in my Excel workbooks because 
I find they clutter the screen. If I want gridlines in specific areas, such as in my tables, I 
add them using the Borders formatting tool. I also prefer to use a standard 12- point 
Calibri font for all my workbooks because that font has been designed to be more 
readable for both text and numbers. To learn more about the Calibri font, see the April 
2017 topic “What Fonts Work Best in Excel,” (tinyurl.com/XXX).   
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14. Add File Properties. In some cases, it may be worthwhile to edit the Excel workbook’s File 
Properties, so users can locate and identify the file more easily in searches. To do this, 
select the File tab, Properties, Advanced Properties, and on the Summary tab, add 
Keywords, Comments, and other information that might make the file easier to locate.  

 

15. Cross-footing and error-checking formulas. Whenever possible, well-labeled cross-
footing totals and/or error-checking formulas should be included in the worksheet. For 
example, a simple IF function might be used to check to see if the balance sheet balances; 
if not, then the error-checking formula should display a message warning the user that 
the worksheet has a problem. 

16. Worksheet protection. In some cases, it may be advantageous to turn on worksheet 
protection to secure the integrity of a completed workbook. To do so, first select each 
assumption cell in the worksheet (one at a time or all at once by holding down the Ctrl 
key to select multiple assumption cells), then right-click one of the selected cells, select 
Format Cells from the pop-up menu, and then, on the Protection tab, uncheck the box 
labeled Locked, as pictured below. (The previous measure of highlighting assumption cells 
in yellow will make it easier to identify them for unlocking purposes.) 
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Next, from the Review tab, select the Protect Sheet option, enter a password (or you can 
leave the password field blank to protect the worksheet with no password), and then click 
OK. Thereafter, changes can only be made to those cells that have been unlocked. To fully 
modify the worksheet later, you will need to turn worksheet protection off to make 
changes to those locked cells from the Review tab by selecting Unprotect Sheet, and 
enter the password, if necessary. Perhaps the best reason to protect your worksheet is to 
prevent accidentally deleting data. Consider the scenario in which your doughnut falls out 
of your hand and bounces off the spacebar and onto the floor. You don’t notice that data 
have been deleted from your worksheet because you are on the ground hurrying to obey 
the five-second rule. In this case, worksheet protection will protect your data but not your 
doughnut. 

 

PRINTING ALL EXCEL SHEETS 
 
Q. I have an Excel workbook with 13 worksheets, and I want to print all the worksheets at once 
instead of one at a time. Should I write a macro to do this? 
 
A. While a macro could be created to print all your worksheets as a single print job, this is not the 
best approach. The easiest approach is to right-click a worksheet tab, choose Select All Sheets, 
and then print normally to have the worksheets printed as a single print job. As an alternative, 
you could also select File, Print, Settings, Print Entire Workbook to achieve the same result. 
 

 
 
Here are a few additional comments about printing multiple worksheets as a single print job. 
 

1. Page numbering. Besides speed, an additional benefit of printing multiple worksheets as 
a single print job is that all of your pages are numbered sequentially. 

2. Custom print settings for each worksheet. Excel’s Page Layout tab’s Page Setup menu 
allows you to customize the way each worksheet prints, even when multiple worksheets 
are selected for printing. For example, Sheet 1 may be set to print in a Landscape 
orientation, Scaled to fit the width of the paper, while Sheet 2 may be set to print in 
Portrait orientation with No Scaling; thereafter, each worksheet adheres to those 
settings, even when both worksheets are printed as a single print job. To customize a 
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worksheet’s layout, select it and from the Page Layout tab, use the Margins, Orientation, 
Size, Print Area, Breaks, Background, and Print Titles tools (pictured below) to adjust 
each worksheet’s layout settings.   

 

3. Printing selected worksheets. Instead of printing all worksheets, you can print selected 
worksheets as a single print job by holding the Ctrl key and left-clicking each tab you want 
to print with your mouse pointer (to select them). For example, in the screenshot below, 
I have selected the tabs labeled January, March, April, and June, which enables me to 
print those four worksheets only. 

 

4. Specifying print range. By default, Excel prints all data contained on each worksheet, but 
you can specify a specific print range for each worksheet using the Page Layout’s, Print 
Area, Set Print Area tool; thereafter, only the specified area will print.  

 

THIS EXCEL FORECAST WAS BOUND TO HAPPEN 
 
Q. Our company creates seasonally adjusted revenue forecasts in Excel 2016 based on historical 
data using regression analysis. I would like to improve our results by also charting the seasonally 
adjusted upper- and lower-bounded forecast ranges, based on a confidence level of 95%. Can 
you tell me how this might be done? 
 
A. Excel 2016 provides a new tool called Forecast Sheet that automatically calculates and plots 
your upper and lower forecast boundaries based on your desired level of confidence, and this 
new tool is smart enough to also calculate and incorporate seasonality into your upper- and 
lower-boundary forecasts. To use this tool, highlight your historical data, including dates, as 
pictured in columns B and C in the example screenshot below.  
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From the Data tab, select Forecast Sheet, expand the tool’s Options if necessary, adjust the 
desired level of Confidence Interval (95% in this example) if necessary, adjust the Seasonality 
setting as desired, and then click Create to produce the new forecast (on a new worksheet), an 
example of which is pictured below.  
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As you can see pictured above, the chart depicts the forecast revenue line (the bolded orange 
line), as well as upper and lower forecast revenue lines depicting the upper and lower boundaries 
of the forecast based on the specified level of confidence (the nonbolded orange lines). You can 
also see that historically (shown as the blue line) the company’s revenue has spiked in the June–
August time frame each year; accordingly, the Forecast Sheet tool has automatically factored this 
seasonality into both the revenue and boundary forecasts.   
 
It is interesting to note that the Forecast Sheet tool produces the forecast results using the two 
new Excel 2016 functions FORECAST.ETS and FORECAST.ETS.CONFINT, as depicted in the chart’s 
underlying data table pictured below. 
 

 
These new functions predict future values based on historical time-based data using the AAA 
version of the exponential smoothing (ETS) algorithm with the weights assigned to data variances 
over time in proportion to the terms of their geometric progression based on the following 
exponential scale {1, (1 − α), (1 − α)2, (1 − α)3, ...}. In lay words, this approach weights the data’s 
seasonal variations by exponentially increasing amounts over time; hence in this example, the 
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revenue’s seasonality in 2015 has a greater impact on the forecast than the seasonality of the 
data in 2014, and 2014’s seasonality impacts the forecast more so than 2013’s seasonality, and 
so on. 
 
If you are using an older edition of Excel, and the Forecast Sheet tool and functions are not 
available to you, you can still adjust your forecast and boundary calculations for seasonality 
manually. For example, the worksheet pictured below includes actual revenue for 2015 on row 
2, linear-based forecasts calculations on row 6, and simplified boundary calculations on rows 7 
and 8. These calculated data are then seasonalized on rows 12, 13 and 14 based (highlighted in 
orange) on the actual seasonality achieved in 2015 by dividing each calculation (highlighted in 
green) by the total amount of revenue for 2015, and then multiplying the product by the actual 
revenue amounts for each respective month in 2015.  
 

 
Download this example workbook at carltoncollins.com/forecast.xlsx.  

 

MODIFY AUTO-CORRECT  
 
Q. Is there a way to turn off the auto-correct function for certain abbreviations or character 
strings in Outlook, Word, and other Office programs? For example, when I enter the ticker for 
Accenture, ACN, Word incorrectly autocorrects my entry to CAN. 
 
A. Word's AutoCorrect function contains corrections for many commonly misspelled or mistyped 
words. You can remove a particular AutoCorrect setting in Word by 
selecting File, Options, Proofing, AutoCorrect Options, and in the resulting AutoCorrect dialog 
box, entering acn in the Replace box to find the unwanted entry, and then with the offending 
entry highlighted, clicking the Delete button, as indicated in the screen shot below. This action 
will remove the unwanted Auto-Correct setting for all Microsoft Office applications. 
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EXCEL DATING PROBLEMS 
 
Q. When I paste a large amount of data into Excel containing dates as far back as the 1800s, the 
recent dates display correctly as valid dates, but the older dates automatically convert to text. I 
assume I need to adjust a setting in Excel, but I can’t find it. Can you help? 
A. Excel handles dates occurring on or after 1/1/1900 perfectly (1/1/1904 in Excel for Mac as a 
default), but earlier dates are problematic. You can easily see the problem simply by entering 
12/31/1899 and 1/1/1900 into Excel using the Long Date format, as pictured below—notice that 
the earlier date is displayed as text while the later date is displayed as an actual date.   
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All editions of Excel have this problem in that they were never designed to handle dates earlier 
than 1/1/1900; Excel’s date system simply numbers the days from 1/1/1900, with “1” 
representing Jan. 1, 1900, and so on. This anomaly is officially blamed on Lotus 1-2-3, which did 
not handle leap years correctly, so Excel’s developers included the same errors intentionally to 
preserve compatibility with Lotus 1-2-3 spreadsheets. To this day, Excel displays Feb. 29, 1900, 
as a valid date, even though that date did not occur (1900 was not a leap year because it is evenly 
divisible by 100 but not by 400). 
 
To further compound calendar problems, different parts of the United States converted from the 
Julian calendar system to the Gregorian calendar system (which incorporates leap years) at 
different times using different approaches. As examples, Arizona, California, Florida, Nevada, 
New Mexico, and Texas followed Spain’s conversion approach, and as a result, the dates Oct. 5, 
1582, through Oct. 14, 1582, are not recognized as having occurred in those states. The 
Mississippi Valley area followed France’s approach, and as a result, that locality does not 
recognize the dates Dec. 10, 1582, to Dec. 19, 1582. Oregon, Washington, and the Eastern 
Seaboard followed England’s approach, and as a result, the dates Sept 3, 1752, through Sept. 13, 
1752, are considered to never have occurred. Microsoft Excel does not attempt to account for 
any of these missing dates; instead Excel simply treats dates before 1900 as raw text rather than 
true dates, thereby avoiding these complicated date conversion issues.     
 
The most frequently occurring problem caused by this issue relates to sorting date lists composed 
of dates both before and after Jan. 1, 1900. To sort pre- and post-1/1/1900 dates, you can 
reformat them using the yyyy/mm/dd custom format; for example, July 4, 1776, would appear 
as 17760704 and all dates formatted in this manner would sort properly. However, if you need 
to perform calculations using these dates, you have a bigger problem that cannot be solved by 
changing the format. Two suggestions for overcoming this date issue as they pertain to date 
calculations are as follows. 
 

• Microsoft provides an explanation for calculating ages dating back to before 1/1/1900 
using a macro approach at tinyurl.com/pq4gbft.  

• The free XDate Excel add-in provides eight new functions to help users work with pre-
1900 dates; this add-in is available at tinyurl.com/lkjmh.  

 
Also, be aware that a secondary problem caused by this date issue is Excel’s WEEKDAY function 
returns the wrong day of the week for all dates earlier than March 1, 1900, a problem that can 
be resolved simply by adding 1 to the WEEKDAY function formula when referring to pre-March 
1, 1900 dates, as explained on the Microsoft support page at tinyurl.com/lcxlndk.  

http://tinyurl.com/lkjmh
http://tinyurl.com/lcxlndk
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MORE EXCEL DATING PROBLEMS 
 
Q. Help! My future value calculations don’t make any sense (see the attached spreadsheet). The 
formula in column D is the same for all rows, but for unknown reasons, it stops working after row 
7. What’s going on? 
 

 
A. Your formula is perfect, but your worksheet reveals a date problem all CPAs should be wary of 
relating to entering two-digit year dates. When you enter a two-digit year using the digits 00 to 
29, Excel then assumes you mean 2000 to 2029; but when you enter dates into Excel using the 
two digits ranging from 30 to 99, Excel assumes you mean 1930 to 1999. If you expand the 
formatting in column C to display four-digit years, you can instantly see that the dates on rows 
eight through 10 refer to 1900 dates, not 2000 dates, as pictured. You only need to edit your 
dates to solve your problem.  

  
(Note: By default, Excel displays four-digit years for all dates, so ordinarily you should have 
noticed this problem right away. However, in this case it appears that you have changed your 
default year format to display two-digit years, just as I always do with Excel so that my dates fit 
in the default Excel column width.) 
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You can avoid this type of problem in the future simply by entering four-digit years instead of 
two-digit years, so Excel does not have to guess which century you mean. Another option is to 
adjust Excel’s two-digit-year interpretation settings, as follows. In Windows 8’s Control Panel, 
select Region (or Clock, Language, and Region and then Region and Language in Windows 7 or 
Vista), click the Additional Settings button, select the Date tab, and then in the Calendar area 
adjust the interpretation settings for two-digit years, as pictured below. You will then need to 
restart Excel.    

 
 
This adjustment will change the default way two-digit years are handled for all of your programs 
that abide by your Region settings (i.e., not just Excel but additional programs such as Access and 
Outlook as well).  
 

TWO-DIGIT DATE PROBLEMS 
 
Q. Help! I imported 140,000 rows of data into Excel with each row containing two-digit-year dates 
formatted as text, but I need to display four-digit-year dates. I’ve tried numerous approaches 
described on the internet, but none work for all my dates. Is there actually a way to convert two-
digit-year dates into four-digit years?  
 
A. Be aware that Excel has no way of knowing whether the date 03/21/10 refers to 1710, 1810, 
1910 or 2010—so the solution you seek may be beyond the scope of Excel’s capabilities, 
depending upon the date ranges you are working with. That said, presented below are five 
common formula-based approaches to solving your two-digit-year date problem, all of which fall 
short to a certain extent. (I’ve explained the shortcomings for each approach below.) You can 
download the Excel workbook (pictured below) containing these examples at 
www.CarltonCollins.com/2digits.xlsx.  

http://www.carltoncollins.com/2digits.xlsx
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1. REPLACE RIGHT/LEFT/LEN approach. The lengthy formula 
=REPLACE(RIGHT(A2,2),1,2,LEFT(A2,LEN(A2)-2)&19&RIGHT(A2,2)) deconstructs the text 
date and then reconstructs that date using a four-digit year by inserting 19 in front of the 
two-digit year. Unfortunately, this formula approach returns the wrong date for all dates 
not occurring in the 1900s. This approach also results in a text-based result that is more 
difficult to sort and work with than date-based results.  

2. LEFT/LEN/RIGHT approach. Like solution No. 1 above, the formula =(LEFT(A2,LEN(A2)-
2)&"19"&RIGHT(A2,2))+0 also inserts a 19 in front of the two-digit year to solve the 
problem; therefore this approach also returns the wrong date for all dates not occurring 
in the 1900s. However, this approach does result in a date-based answer, which is an 
improvement over solution No. 1. 

3. SUBSTITUTE approach. Like the previous two approaches, the formula 
=SUBSTITUTE(A2,"/","/19",2)+0 also inserts a 19 in front of the two-digit year to solve the 
problem; hence this approach also returns the wrong date for all dates not occurring in 
the 1900s. However, this approach does result in a date-based answer and is a simpler 
solution than approach No. 2. 

4. TEXT approach. The function =TEXT(A2,"dd/mm/yyyy") will display your two-digit years 
as four-digit years, but this approach adheres to the 1900 versus 2000 assumptions 
explained in the previous topic related. This approach returns a better result than the 
three previous approaches, but the results are still text-based—hence the results are 
more difficult to work with. 

5. TEXT/DATE approach. The best solution is to use the TEXT approach described in the 
previous paragraph, coupled with the DATE function, which converts the text-based result 
to date-based result, as follows: =DATE(RIGHT(TEXT(A2,"dd/mm/yyyy"), 
4),MID (TEXT(A2,"dd/mm/yyyy"),4,2),LEFT(TEXT(A2,"dd/mm/yyyy"),2)). This approach 
produces a date-based result that follows the assumptions you specify in Excel for 
handling two-digit years that occur before and after 29. However, you still face the basic 
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problem that Excel can’t tell for sure whether two-digit years are supposed to refer to the 
2000s, 1900s, 1800’s or earlier.  

3 WAYS TO CALCULATE INTERNAL RATE OF RETURN IN EXCEL 
 
Q. I have prepared projections for a proposed project, and I want to calculate the internal rate of 
return. Instead of using Excel’s IRR function, should I use simple math formulas so others can 
follow my calculations? 
 
A. Excel offers three functions for calculating the internal rate of return, and I recommend you 
use all three. The problem with using math to calculate the internal rate of return is the necessary 
calculations are both complicated and time-consuming. Basically, a math-based solution involves 
calculating the net present value (NPV) for each cash flow amount (in a series of cash flows) using 
various guessed interest rates on a trial-and-error basis, and then those NPVs are added together. 
This process is repeated using various 
interest rates until you find/stumble 
upon the exact interest rate that 
produces NPV amounts that sum to 
zero. The interest rate that produces a 
zero-sum NPV is then declared the 
internal rate of return.  
 
To simplify this process, Excel offers 
three functions for calculating the 
internal rate of return, each of which 
represents a better option than using 
the math-based formulas approach. 
These Excel functions are IRR, XIRR, and 
MIRR. Explanations and examples for 
these functions are presented below. 
You can download the example 
workbook at carltoncollins.com/irr.xlsx.  
 

1. Excel’s IRR function. Excel’s IRR 
function calculates the internal 
rate of return for a series of cash 
flows, assuming equal-size 
payment periods. Using the 
example data shown above, the 
IRR formula would be 
=IRR(D2:D14,.1)*12, which yields an internal rate of return of 12.22%. However, because 
January has 31 days, and February has either 28 or 29 days, the monthly periods are not 
exactly the same length, therefore, the IRR will always return a slightly erroneous result 
when multiple monthly periods are involved.  
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2. Excel’s XIRR function. Excel’s XIRR function calculates a more accurate internal rate of 
return because it takes into consideration different-size time periods. To use this function, 
you must supply both the cash flow amounts as well as the specific dates in which those 
cash flows are paid. Many CPAs tend to prefer XIRR over IRR because yields slightly more 
accurate results. In the example pictured above, the XIRR formula would be 
=XIRR(D2:D14,B2:B14,.1), which yields an internal rate of return of 12.97%. 

3. Excel’s MIRR function. Excel’s MIRR function (modified internal rate of return) works 
similar to the IRR function, except that it also considers the cost of borrowing the initial 
investment funds as well as compounded interest earned by reinvesting each cash flow. 
The MIRR tool is flexible enough to accommodate separate interest rates for borrowing 
and investing cash. Because the MIRR function calculates compound interest on project 
earnings or cash shortfalls, the resulting internal rate of return is usually significantly 
different from the internal rate of return produced by the IRR or XIRR functions. In the 
example above, the MIRR formula would be =MIRR(D2:D14,D16,D17)*12, which yields an 
internal rate of return of 17.68%.   

Note: Some CPAs maintain that the MIRR function’s results are less valid because a 
project’s cash flows are rarely fully reinvested. However, clever CPAs can compensate for 
partial investment levels simply by adjusting the interest rate according to the expected 
levels of reinvestment. For instance, if it is assumed that reinvested cash flows will earn 
3.0% but only half the cash flows are expected to be reinvested, then the CPA can use an 
interest rate of 1.5% (half of 3.0%) as the interest rate to compensate for the partial 
investment of cash flows. 

Rather than worrying about which method produces the more accurate result, I believe the best 
approach is to include all three calculations (IRR, XIRR, and MIRR) so the financial reader can 
consider them all. A few comments about these calculations follow. 
 

1. Negative and positive cash flow values required. All three functions require at least one 
negative and at least one positive cash flow to complete the calculation. The first number 
in the cash flow series is typically a negative number that is assumed to be the project’s 
initial investment.  

2. Monthly versus annual yields. When calculating the IRR or MIRR of monthly cash flows, 
these two functions yields a result that must be multiplied by 12 to produce an annual 
yield; however, the XIRR function automatically produces an annual result that does not 
need to be multiplied. When calculating the IRR, XIRR, or MIRR of annual cash flows, the 
results do not need to be multiplied. (Because the XIRR function includes date ranges, it 
annualizes the results automatically.)  

3. Guess. The IRR and XIRR functions allow you to enter a guess as the beginning rate where 
the function starts calculating incrementally, up to 20 cycles for the IRR function and 100 
cycles for the XIRR function, until an answer within 0.00001% is found. If an answer is not 
determined within the allotted number of cycles, then the #NUM! error message is 
returned.   
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4. The #NUM! error. If the IRR function returns a #NUM! error value, or if the result is not 
close to what you expected, Excel’s help files suggest you try again with a different value 
for your guess.  

5. If you don’t enter a guess. If you don’t enter a guess for the IRR or XIRR functions, Excel 
assumes 0.1, or 10%, as the initial guess. 

6. Dates. The dates you enter must be entered as date values, not text, for the XIRR function 
to accurately use those dates.  

 

EXCEL’S EVALUATE FORMULA TOOL 
 
Q. I’ve accepted a new job at a property management company that uses an Excel worksheet to 
calculate agent bonuses for each lease agreement executed. The bonus calculation (pictured 
below) seems to work correctly, but the formula is so complicated (circled in red below), I can’t 
follow it. Any suggestions?   
 

 
 

A. A good approach to understanding complicated Excel formulas is to dissect them using Excel’s 
Evaluate tool, as follows. Select the complicated formula, and then from the Formula tab, select 
Evaluate Formula to produce the dialog box pictured below.  
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Next, click the Evaluate button repeatedly to step through the complex calculation one step at a 
time. This will enable you to carefully study each step of the formula’s mathematical progression 
from start to finish, which hopefully will aid your understanding. In this example, it takes 71 
separate mathematical steps for Excel to complete the calculations contained within this one 
formula, so it’s easy to understand why you struggled to understand it. I don’t have room to show 
all 71 steps, but pictured below are the Evaluate Formula tool’s mathematical progression for 
the 25th, 50th, and 70th steps, to give you an idea as to how the tool works.  
 

 
 

With each subsequent click of the Evaluate button, another small part of the formula is revealed 
until, ultimately, the entire formula is solved. After studying the formula a few times using the 
Evaluate Formula tool, I was able to grasp the formula’s intent, which is to calculate up to six 
possible bonuses for each lease agreement transaction executed by your sales agents, and then 
add them together. Those six bonus calculations are as follows: 
 

Bonus 1 - $100 if the agreed-upon rental rate exceeds $1,100. 
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Bonus 2 - $100 if length of lease exceeds 12 months. 
Bonus 3 - $100 if the deposit received is equal to or greater than one month's rent. 
Bonus 4 – $100 if the tenant’s credit rating exceeds $700. 
Bonus 5 - $100 if the property remains vacant for less than 35 days. 
Bonus 6 - $250 if all 5 bonuses mentioned above are earned. 
 

As a result, leasing agents can earn up to $750 in bonuses for each executed lease agreement 
they negotiate, if all the company’s favorable conditions are met. I concur that the formula works 
properly, but it contains embedded assumptions, which is never a good idea. Further, the formula 
is overly complicated and should be simplified. I have found that many people write complicated 
formulas like this one in a single cell, when it would likely be easier to write several simpler 
calculations across multiple cells. Pictured below is an example of how I would restructure this 
bonus calculation so others could more easily follow, review, and edit this worksheet in the 
future.  
 

 
 
As you can see, I have replaced the single complicated formula (formerly in cell D11) with 27 
separate cells (on rows 11 through 18), including bonus amounts, bonus descriptions, bonus 
criteria, formulas, and column titles. The resulting worksheet is easier to follow, and writing the 
six separate formulas was surely much easier and faster than creating the single gigantic formula. 
In addition, instead of embedding the bonus and criteria amounts in the complicated formula, I 
have broken those values out into separate cells for easier review and editing. I’ve also added 
yellow background and border highlights to those cells where assumptions are entered, to make 
it easier for others to follow and use the worksheet in the future. While the Evaluate Formula 
tool is useful, I would advise CPAs to design their worksheets in such a way that others will have 
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no need to use the Evaluate Formula function to follow their work. You can download this 
workbook at www.CarltonCollins.com/Evaluate.xlsx.  
 

A FORMULA FOR GOING GREEN 
 
Q. Is there a way to conditionally format Excel so that my formulas automatically display a 
different font color?  
 
A. You can color-code your formulas using Excel’s conditional formatting tool as follows. Select a 
single cell (such as cell A1). From the Home tab, select Conditional Formatting, New Rule, and in 
the resulting New Formatting Rule dialog box, select Use a formula to determine which cells to 
format. In the resulting Format values where this formula is true box, enter the formula 
=ISFORMULA(A1) (make sure that no dollar signs appear in the formula). Click the Format button 
(near the lower-right portion of the dialog box) and select a desired color from the color 
dropdown box (I have selected green in the example below), and then click OK, OK. (Note: I also 
selected Bold from the Font style box so the formulas would stand out a little more). 
 

 
 
In this example, we have now successfully applied conditional formatting to cell A1, which will 
display a bold, green font whenever a formula is entered into cell A1. Next, to apply this 
formatting to the entire worksheet, select cell A1, right-click cell A1, click the Format Painter tool 
icon, and then click the upper-left corner of the worksheet (in the row and column heading area) 
to apply this format to the entire worksheet. Thereafter, your entire worksheet will highlight all 
formulas using a bold, green font, an example of which is pictured below.  

http://www.carltoncollins.com/Evaluate.xlsx
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You can download this example workbook at carltoncollins.com/formulacolor.xlsx.  
 

PUT THIS CHART ON YOUR RADAR 
 
Q. Our company is in the process of interviewing, evaluating, and hiring a group of new 
employees, using a detailed checklist and interviewer rating system. Now that we have all this 
data, is there a visual method for comparing how well-rounded one candidate is compared to 
another candidate? 
 
A. Excel can produce a filled radar chart, which can be useful for comparing a multitude of 
attributes across multiple items, and the visual results may be the solution you seek. To illustrate 
this type of chart, I prepared sample data consisting of 12 measurements for three prospective 
employees (Ben, Sally, and Fred), and I arbitrarily assigned scores to each employee, as pictured 
below. (I used a Concatenate formula to include the scores totals in the column heading; for 
example, cell C1 contains the formula ="Ben ("&C14&")". This trick enables each employee’s 
score total to be reflected in the resulting charts pictured farther below.) 
 

 

http://www.carltoncollins.com/formulacolor.xlsx
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To create the first radar chart, I selected the list of measurement points in column B and the 
scores for Ben in column C (cell range B1 through C13 in this example), then from the Insert tab, 
I selected the Filled Radar chart option, as pictured below. 
 

 
 
With the chart still selected, from the Chart Tools menu, I then applied the Style 5 chart 
formatting from the Chart Styles box to produce a dark gray background with light blue area 
formatting, and I formatted the gridlines as solid lines. I repeated the process for Sally and Fred 
to produce side-by-side radar charts for all three candidates, which may help to visually tell the 
story of each candidate’s strengths and weakness.  
 

 
 
Presumably, a more circular area infers a better-rounded candidate, but only if all measurement 
attributes are weighted equally. In the end, remember that computers aren’t intelligent (they 
only think they are), and because many additional factors should be considered, your final 
selections should be based on more than the shape of a simple computer chart. You can 
download this radar chart example at carltoncollins.com/radar.xlsx.  
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